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Allocation Unit
A storage unit made up of one or more sectors, depending on the size of the disk. The 
smallest unit of DOS file space allocation. Same as cluster.



Archive Attribute
The symbol (a) that marks files that have been changed after they were last backed up. 
Backup applications clear the archive attribute. You can clear it manually in the File Manager
File menu Properties dialog box.



Ascending Order
A sorting method. When this method is used, items are sorted from A to Z, smallest to 
largest, or earliest to latest.



ASCII
The set of text codes used by DOS. The basic set includes 128 letters, numbers, punctuation
marks, and other codes. Most computers recognize the extended ASCII set of 256 
characters, which includes line-drawing and international characters.



Associate
Specify the application that runs documents that have a specific file type. 
You cannot open a file directly unless it is associated with an application. After a file type is 
associated with an application, when you run or open any file with that file type, you start 
the associated application. 
To run an individual file in a different application, first launch the application you want to 
use, and then open the file from the application.



AUTOEXEC.BAT File
A batch file in the root directory that is executed every time you start your computer. This 
file contains DOS instructions used to initialize system settings, such as your DOS PATH, load
memory-resident programs, and launch applications.
AUTOEXEC.BAT is run after CONFIG.SYS. 



BIOS
Basic Input/Output System. The routines stored on the ROM chip on your system 
motherboard that control such functions as video display, keyboard input, and printer 
control. Your computer uses these instructions to prepare to load DOS.



Boot Sector
The first sector on a disk. It contains a small startup program that loads and starts DOS.
If the boot sector on your hard disk is damaged, you cannot boot your system normally. Use 
your emergency disk to boot the computer and run DiskFix to repair the boot sector if 
possible. 



Bootable Disk
A disk that contains the basic operating system files that start your system.
On most systems, if there is a disk in the A: drive, the system will try to boot from that disk. 
Make sure that your emergency or bootable disk can be run from your A drive or the floppy 
drive your system uses as a boot drive when it contains a disk.



Case-sensitive Search
A search for characters that match upper and lower-case letters exactly as typed.



CGA
Color Graphics Adapter. A graphics standard used in many early PCs, CGA allows 16 colors 
and can display only ASCII characters or low-resolution bit-mapped graphics.



Cluster
The smallest unit of DOS file-space allocation. Same as allocation unit.



CMOS
Complementary Metal-Oxide Semiconductor. A battery-powered semiconductor on the 
motherboard of your computer. It stores the system date and time, and information about 
the memory and disk drives on your system.



Compress Command
Reduces the size of files so that they take up less disk space. Some files can be reduced by 
50% or more.
The Expand command restores compressed files to their original size so you can use them 
again. File Viewer can display the contents of a compressed file. File Manager lets you launch
compressed files directly from their compressed format in a compression file set.
Several individual compressed files can be stored in one compression file.



Compression File
A file that contains one or more compressed files.
In File Manager, you can create an empty compression file with the Create Directory 
command on the File menu and use it as if it were a directory. You can delete, copy, or move 
individual compressed files into and out of it. You can also view the compressed files.
Compression files are useful for storing large files you use occasionally, or for sending files 
to another user.



CONFIG.SYS File
A configuration file in the root directory that is executed on startup before AUTOEXEC.BAT. 
This file might contain commands that configure memory, set    internal system commands, 
or load device drivers necessary for the normal operation of your computer.



Confirm
Respond to a prompt that asks you to approve an action such as deleting a file. 
By default, Windows displays a dialog box asking you to press Return or click OK to confirm 
that you want to delete or move a file, or copy a file that will write over an existing file.



Contiguous
Elements that are immediately adjacent to each other.
For example, if all clusters assigned to a file are in sequence on the disk, the file is 
contiguous. If the clusters are located in different parts of the disk, the file is fragmented.



Copy-protected Software
Contains a program of hidden instructions intended to prevent you from making 
unauthorized copies. 



CPU
Central Processing Unit. The chip that executes instructions on your computer. Its speed and 
abilities depend on its type: the 8086 chip was used for the original PCs and XTs, then the 
80286, and 80386 or 80486 for some of today's PCs. Some of the newest PCs contain even 
more powerful CPU chips. 
Some computers have a separate, additional math coprocessor chip, while others rely on 
math coprocessor emulation. The 80486DX has its math coprocessor built in.



Cross-linked Files
A file-storage error that occurs when one cluster is assigned to more than one file. 
Like lost clusters, cross-linked files can occur when the computer is interrupted by a system 
crash or a power outage while it is saving a file. 
Run DiskFix to repair cross-linked files. 



Custom Command
A command that you create through the Options menu Customize Commands dialog box. A 
custom command can be another Windows application, a DOS application that has an 
associated PIF file, or a ScriptTools compiled script.

Add custom commands to the Toolbar or any menu in the application you are 
running. Select Customize Menus or Customize Toolbar from the Options menu Customize 
command.



Cylinder
The set of tracks on a disk that occupy the same position on each side of each disk platter.
On a single, double-sided disk,    cylinder 1 includes track 1 of the top and bottom sides. On 
hard disks with several platters, cylinder 1 is made up of track 1 on the top and bottom of 
each platter.



Data Encryption Standard (DES)
An encryption standard established by the National Bureau of Standards. The DES technique
allows information to be transformed into an apparently random stream of bits for security 
reasons. It uses a binary number or string of binary values as an encryption key. Each key 
results in a different encoding pattern. 
Full DES encryption performs the substitution table pass 16 times. Quick encryption 
performs the substitution table pass twice. Even two passes make the file extremely secure. 
However, full DES encryption is required by US Department of Defense standards.
Note
DES encryption is available to US and Canadian users, but it is not supplied with the 
standard version of PC Tools for Windows. If you need DES encryption and are entitled to use
it, you can download WNDES2.DLL from the Central Point BBS, or from the Central Point 
Software forum on CompuServe. You can also call Central Point and ask us to send you the 
DLL.



Default
The settings or configuration a program uses when it first starts up. 
You can change default values temporarily or permanently. If you change defaults 
permanently by saving the changes, then the new settings are the defaults.
Note, however, that some programs allow you to reset to the original defaults shipped with 
the product. To recover factory defaults for most programs, you have to reinstall the 
program.



Delete Sentry
A Central Point Software data protection method that saves whole deleted files in a hidden 
directory named \SENTRY. You can specify what kind of files are saved for later recovery.
A file protected by Delete Sentry can be reliably restored because the file itself is saved. See
Delete Tracker for comparison.



Delete Tracker
A Central Point Software data protection method that saves the name of each deleted file 
and its cluster numbers in a hidden file named PCTRACKR.DEL. 
A file protected by Delete Tracker can be reliably restored if none of its clusters have been 
written over by more recent files, or if you have not run a disk defragmentation program 
such as Optimizer, which relocates file clusters. See Delete Sentry for comparison.



Descending Order
A sorting method. When this method is used, items are sorted from Z to A, largest to 
smallest, or latest to earliest.



Device Driver
A program, usually loaded in your CONFIG.SYS file, that controls a device attached to your 
system, such as a mouse or printer, or manages a system component, such as expanded 
memory or a compressed drive.



Disk Label
A name you give to a disk or disk volume so that you can identify it. Disk label names can 
contain as many as 11 characters.



DOS
Disk Operating System. The system software that lets your programs communicate with 
your PC and its drives, monitor, and other components. DOS also contains a collection of 
commands, such as COPY and DIR, that do tasks like copying and organizing files.



DOS File Names
A DOS file name consists of two parts, the file name and the file extension, separated by a 
period. The file name can contain up to 8 characters. The file extension can contain up to 3 
characters. 
You can use the following characters in DOS file names:

A - Z and 0 - 9, underscore (_), caret (^), dollar sign ($), tilde (~), exclamation point (!), 
number sign (#), percent sign (%), ampersand (&), hyphen (-), curly braces ({}), 
parentheses (()), at sign (@), apostrophe or right single quote ('), grave accent or left 
single quote (`).

You cannot use backslash characters, commas, spaces, or extra periods. 



Drag-and-Drop
A method of acting on objects by selecting them with your mouse, holding down the mouse 
button, and dragging the file name or object to a new destination, where you release the 
mouse button to drop it into place.



EGA
Enhanced Graphics Adapter. A video graphics standard that can display up to 16 colors at a 
time from a palette of 64 colors, at a resolution of 640 horizontal pixels by 350 vertical 
pixels.



Encrypt
To encode ordinary files so that they cannot be read or executed until they are decrypted. A 
method of securing data from unauthorized or improper use.



Environment Variable
A string of characters that DOS translates to a path name. Many programs use environment 
variables to locate files. 
For example, a database program may translate the environment variable DBASEDAT to find 
out where data files are stored. You might use the DOS SET command to specify the name of
the drive and directory where the files are kept. If you keep your files in D:\DATAFILE, you 
enter the following line in your AUTOEXEC.BAT file to create the DBASEDAT environment 
variable.

SET DBASEDAT=D:\DATAFILE



Expanded Memory
One method of using memory above the 640K limit of conventional DOS RAM. Expanded 
memory, also known as EMM or EMS memory, is controlled by a memory manager such as 
QEMM, 386MAX, or DOS EMM386. Windows uses extended memory instead, but you may 
still need expanded memory if you run older DOS applications.



Extended Memory
Memory above the 640K limit of conventional DOS RAM. Extended memory, also known as 
XMS, is used by Windows to run faster and more efficiently.



File Allocation Table (FAT)
A reserved area that DOS uses to keep track of all clusters on the disk or partition. The FAT 
contains information about which clusters are assigned to which files, and marks bad 
clusters so that they cannot be used to store data.



File Attribute
A specific characteristic that describes properties of a file. For example, a file may have 
attributes that define it as hidden or read-only.
The following are DOS file attributes:
System (s) Used by the operating system and not listed by the DIR command.
Hidden (h) Not listed by the DIR command.
Read-only (r) Cannot be written to or deleted. 
Archive (a) Changed since last backup.
Directory (d) A subdirectory.
Networks use additional file attributes.



File Properties
File name and type, size, creation and modification dates, path and access specifications, 
and all file attributes.



File Type 
File type is determined by the file extension, which are the characters that follow the period 
in the file name. 
A DOS file extension can contain as many as three characters. For example, FILE.TXT has a 
file type of TXT and PROGRAM.C has a file type of C.
The file type is used to associate a file with an application that runs it. For example, all files 
with file type TXT are associated with the Windows Notepad application by default.
DOS file names do not always include a file extension: FILE alone is a legitimate DOS file 
name. You cannot associate such a file with an application, however.



Filter
A file-property specification that determines what file names are displayed in a file list, or 
found by a file-search command such as SmartFind.
For example, if you want to delete old files, you might create a filter that selects files last 
modified before January 1, 1993.



Format
Prepare a disk to store data. 
There are two kinds of disk format:
Low-level Prepares the surface of the disk to store data by writing the addresses that

indicate individual sectors. Most hard disks are low-level formatted by the 
manufacturer.

High-level Creates the system areas necessary for data storage, such as the boot 
sector and root directory.

When you format a floppy disk, you perform both a high-level and low-level format.



Fragmented File
A file stored in allocation units that are in noncontiguous sectors on a floppy or hard disk. 



Hardware Interrupt
An interrupt request, or IRQ, that comes from hardware such as a keyboard, mouse, or 
modem. Hardware interrupts tell your CPU when to interrupt operations momentarily in 
order to get information from a hardware device.
For example, when you click your mouse button you send an interrupt to the CPU. The active
application decides how to interpret the information, whether to display a dialog box or 
move the cursor, perhaps.



Hidden Attribute
A DOS file attribute. The Hidden attribute (h) is assigned to files to prevent users from 
seeing the file name in file lists, and then changing or deleting the file.



History List
A list of the most recent entries you have made in a particular text box.
For example, a history list for a file name text box contains the most recently used file 
names. 



Icon
A graphic representation of an object in a computer system. For example, systems using a 
graphical user interface (GUI) use icons to represent objects such as files, applications, 
documents, and disk drives. When you select the icon with a mouse click, you can move the 
icon or access the object it represents.



Idle Time
Time during which a system receives no input, such as keystrokes, mouse clicks, or disk 
activity, and no processing is going on.



I/O Port
An connector used for an input or output device. In most cases, the I/O ports are the serial 
and parallel ports, used to connect modems, printers, and other devices.



Launch
To start an application. 
You can launch an application in several ways:

Double-click a file name in a file list window. You can double-click an application 
name, or the name of a file associated with the application.

Use the File menu Run command.
Double-click an application icon in Desktop.



Logical Drive
Storage space to which a drive letter has been assigned so that you can access it.
A logical drive may be an entire physical disk, such as a floppy disk, or a RAM drive, which 
exists only in memory. It may also be a partition on a large hard disk or a network drive.



Lost Cluster
A cluster that is marked as "in use" in the File Allocation Table (FAT), but is not associated 
with any file. 
Use DiskFix to recover lost clusters so that you can use them.



Mapped Drive
A network drive that has been assigned a logical drive letter on your local system so that 
you can access it.



Math Coprocessor
An auxiliary processor that handles math operations. 
A math coprocessor processes floating-point operations much faster than the CPU. A math 
coprocessor can improve performance in spreadsheets, computer-aided design, and other 
math-intensive applications. 
Some chips, like the 80486DX, have a built-in math coprocessor.



Maximize
To enlarge a window to its maximum size by using the Maximize button, which is the 
upward-pointing triangle at the right of the title bar, or the Maximize command on the 
Control menu.



Media Descriptor Byte
The first byte in the file allocation table, indicating what kind of disk it is, such as a 360 K 
floppy disk. 



Memory
The short-term electronic storage area in a computer system. When you turn the computer 
off, the contents of memory is lost.



Minimize
To reduce a window to an icon by using the Minimize button, which is the downward-pointing
triangle at the right of the title bar, or the Minimize command on the Control menu.



Modeless Dialog
A dialog box that allows you to work in another window while the dialog box is open.



Mono
Monochrome. A video graphics adapter for a monitor that can display only a single color, 
usually black and white, green, or amber.



Native Mode
The display mode of a file as you see it in the application that created it. 
For example, a spreadsheet file is displayed as you would see it in the spreadsheet 
application.



NetWare File Attributes
Special properties of a NetWare file.

Execute Only Can only be executed. It cannot be 
read or written to.

Sharable Can be used by more than one user at 
a time.

Index Maintained in the network system 
index for quicker access.

Purge Can be erased from the network drive. 
Purged files cannot be recovered.

Copy Inhibit Cannot be copied.
Delete Inhibit Cannot be deleted, even if you have 

Erase access privileges.
Rename Cannot be renamed. 

Transactional Ensures proper file modification. If 
some changes cannot be written, no 
changes are made. The file is left in its 
original state.

Normal Window Size
The application-defined window size. 
You can specify the normal window size for some applications. Some applications remember 
the most recent size of the window, and use that as the normal size. Other applications have
a fixed normal size.



OEM
Original Equipment Manufacturer. An OEM supplies a component to another company, which
sells it under its own name. For example, a brand-name computer usually includes a version 
of DOS, which might be supplied by a different company. The supplying company is an OEM.



Partition
A section of a physical disk that has been formatted with its own partition table, root 
directory, and File Allocation Table (FAT), and assigned a unique logical drive letter.
You can use a disk partition like a separate hard drive. Partitioned drives contain only one 
bootable partition, however.



Physical Drive
The disk actually in the floppy drive or a fixed disk itself. 
A physical drive can be partitioned, or otherwise assigned more than one logical drive letter.



Pixel
An abbreviation for picture element. A pixel is a single dot on a display screen.



Recovery Disk (Emergency Disk)
A special disk that contains a copy of the master boot record on your hard disk as well as 
other unique system information. A recovery disk helps you to reboot your system and 
recover data in an emergency. 



Remote
In network terminology, any peripheral equipment, such as a printer, to which a user has 
access, but is not physically attached to the user's computer.



Root Directory
In hierarchical file systems, the top-level directory from which all subdirectories branch.



Screen Font
A font as displayed on your screen. Screen fonts are designed to match printer fonts closely 
so that your documents look the same on the screen as they do when printed.



Search Group 
A set of files that have specific file extensions. You can create a search group that contains 
files with more than one file extension, such as .EXE, .BAT, and .COM. 
Certain default search groups are created when you use the File Manager Associate 
command to connect files with application applications. You cannot modify these default 
groups except by using the Associate command, but you can create new groups and change 
groups that you have created.



Sector
The smallest data storage unit on a disk. Even if only a single byte of information storage is 
requested, an entire sector is assigned to the file.



Security Standards 
Refers to the computer security standards required by the Department of Defense. These 
standards require a special method for writing over deleted files so that no data can be 
recovered and read. You can select this method of clearing free space, or the Central Point 
standard method.



Select
To mark an item so that you can perform some action. Selected items are usually highlighted
or surrounded by a hollow selection box.



Software Interrupt
Interrupts that programs send to the BIOS or the operating system to request services. For 
example, the Int 21h functions control file management services provided by DOS, such as 
Execute Program and Open File.
Device drivers and TSRs often install their own routines to intercept certain interrupts. For 
example, the VSafe program needs to know when you open a potentially virus-infected file, 
so it checks for the interrupt that opens files.



Sort Key
A key that determines the order in which files are displayed in the File List window. For 
example, if you specify date as the sort key, the names of the most recent files are 
displayed first and the oldest last.
With File Manager, you can specify a primary and a secondary sort key. For example, if you 
specify date as the primary sort key and file type as the secondary, files for each date are 
displayed in alphabetic file type order.



Substitute Drive
A DOS directory to which you have assigned a drive letter with the SUBST command. A 
substitute drive is not a physical drive or a disk partition.
You might create substitute drive A: to refer to C:\INSTALL if you are running an application 
that expects input from floppy drive A, for example, and your files are actually in C:\INSTALL.
If you have assigned drive letter A: to a DOS directory, it cannot be used to access the 
floppy drive on your machine. See your DOS manual for more information about the SUBST 
command.
When you optimize your C: drive, the subdirectory INSTALL and its files are optimized like 
other directories and files.



System Attribute
The DOS file attribute (s) that marks a file used by the operating system or another 
program. System files occupy disk space but do not appear in directory listings.



DOS System Files
The DOS system files are the essential files that run your computer system. 
DOS system files include COMMAND.COM, the command interpreter, which appears as an 
ordinary file in the file list and two other files, IO.SYS and MSDOS.SYS or its equivalent. 
These files must be in the root directory of any disk you boot your system from.
IO.SYS and MSDOS.SYS are hidden files. Unless you use the Custom Filter option on the View 
menu to specify hidden and system files in your file list, you do not see these names in the 
root directory file list.
Note
You probably have other system files on your hard disk. System files are marked with the 
system (s) attribute, and usually have the file type .SYS. Device drivers are often system 
files. Only the DOS system files are copied to a disk when you format the disk with system 
files or use the SYS command to add system files to an already formatted disk.



SYSTEM.INI File
The Windows startup file that contains internal system configuration information for 
Windows. Most of the entries in this file are explained in the SYSINI.WRI file in your Windows 
directory.



Track
A series of sectors on a disk at the same horizontal distance from the edge of the data 
recording area. When the disk's read/write head is stationary, a track is all the sectors that 
spin past the head in each full rotation of the disk.



TSR
A Terminate and Stay Resident program, also called a memory-resident program. A TSR is 
loaded from DOS and stays in memory, working in the background. Device drivers, memory 
managers, VSafe, and VWatch are all TSRs.



UART
 Universal Asynchronous Receiver-Transmitter. A UART circuit, usually enclosed in a single 
chip, controls the serial port on your computer.



VGA 
Video Graphics Adapter. One of the current standards for PC video displays. VGA video can 
display up to 256 colors, at a resolution of 640 horizontal pixels by 480 vertical pixels.



Virus
A program that attaches itself to other programs or data. A virus' typical purpose is to 
disrupt the processing of information on an infected system. When an infected program is 
executed, the virus reproduces and spreads by searching for other software that is not 
infected, and then attaching itself to previously "clean" software.



Whole-word Search
A search option that finds only whole words. For example, if you're searching for the word 
"his," the characters "his" in such words as "this" and "whisper" won't be found. Without this 
option selected, any sequence of characters matching the search text will be found.



Wildcard Character
A character that represents one or more characters. The question mark (?) wildcard can be 
used to represent any single character, and the asterisk (*) wildcard can be used to 
represent any character or group of characters that might match that position in other file 
names. For example, *.EXE represents all files that end with the .EXE file name extension.



Windows Enhanced Mode
One of two operating modes of Windows 3.1. Enhanced mode, unlike standard mode, 
provides virtual memory and allows non-Windows applications to run in the background and 
in a window called a DOS box. The disadvantages of enhanced mode are that it is slower 
than standard mode and uses a significant amount of disk space to provide virtual memory.



Windows Real Mode
One of the Windows 3.0 modes. Windows 3.1 eliminated this mode.



Windows Standard Mode
One of two operating modes of Windows 3.1. Standard mode is faster than enhanced mode 
but does not provide virtual memory. It also does not allow non-Windows applications to run 
in the background or in a window. DOS sessions must run in the foreground and use the full 
screen.



WIN.INI File
A file that contains Windows configuration information. The information in this file can be 
used and modified by any Windows application. 
PC Tools for Windows stores a variable in WIN.INI to tell Windows where to find PC Tools for 
Windows configuration files.




